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Welcome
Welcome to your Callegra.UC Unified Communications system.

As a mailbox owner, you can use unified communication features from 
the telephone, from a desktop client (CallegraINBOX for Outlook or 
CallegraINBOX for GroupWise), or Internet client (CallegraWEB).

This booklet guides you through the Callegra.UC telephone interface, 
helping you set up and use the voice messaging system in an easy, 
straightforward manner. 

It also provides setup instructions for installing desktop client software. 
See “Install Desktop Clients” on page 22. For more information about 
using these desktop clients, see the online help available after 
installation.

Your Personal System
Your administrator has set up a individualized system for your 
company. This setup, along with the capabilities of your telephone 
system, affect the way you use the Callegra.UC system. The voice 
prompts you hear and the features available to you from the telephone 
interface depend on the prompts and features that are enabled or 
disabled for your mailbox.

Some prompts and features are not available by default. Some examples 
of these include: fax, notification, speed dial, wakeup call, urgent 
message option, caller message editing, distribution list control, call 
routing, and message broadcast. 

Ask your administrator to enable a prompt or feature if needed. If you 
are a Callegra.UC Power User, you can enable some of these features 
within CallegraINBOX for Outlook, CallegraINBOX for GroupWise, 
or CallegraWEB.
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Access 
Mailboxes

You can access your mailbox from outside or inside your company. See 
your administrator for the number and specific company instructions. 

The first time you access your mailbox, a tutorial helps you record your 
mailbox name and greeting. It also guides you through entering a 
personal passcode. The default passcode is 1234. Your voicemail access 
number: ____________ 

Access Mailbox from an Outside Line
Access Mailbox from Main Number:

Access Mailbox from Direct Line:

1. Dial the company 
number.

2. Press # when 
the company 
greeting plays.           

3. Enter your 
mailbox number 
and passcode.

1. Dial your direct- 
line telephone 
number.

2. Press * when 
your mailbox 
greeting plays.

3. Enter your 
passcode.
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Access Mailbox from an Inside Line

Leave Message without Ringing Extension

1. Dial the 
voicemail access
number.

2. Enter your      
mailbox 
number if 
prompted.

3. Enter your 
passcode.

2. At the main greeting, 
enter the mailbox 
number, immediately 
followed by the * key.

1. Dia1 the 
company 
number.
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Play Voice 
Messages

When you access your mailbox, you hear the number of new messages 
you have received, followed by the number of saved messages.

Each time you return to the Main menu, you might hear a “chime” tone. 
If you hear this, there is a new message in your mailbox.

Play Messages
To play a message:
1. From the Main menu, press 7 to access the Voice Messages menu.

2. Press 7 to play new messages or press 8 to play saved messages.

Save Messages
To save a message:

1. From the Main menu, press 7 to access the Voice Messages menu.
2. Press 7 to play a new message.

3. Press 5 to keep the message. 
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Record and
Send

Messages

You can make new messages for other mailbox owners, entire 
distribution lists, or even outside telephone numbers. See “Use 
Distribution Lists” on page 19 for more information.

Make a Message
To make a new message:

1. From the Main menu, press 6 to make a new message.
2. When prompted, select 1 to enter an internal mailbox extension 

number, select 2 to enter an outside number, or 3 for Global 
Directory mailbox extension number.

3. Enter a mailbox extension number, the external phone number, or 
press * to enter a distribution list number.

Use Message Delivery Options
After recording a new message, replying to a message, or forwarding a 
message, choose from the following message delivery options:

• Press 9 to deliver the message.

• Press 7 to play the message.

• Press 3 to discard and rerecord your message.

• Press 2 to add a comment to the existing message.

• Press 5 to deliver to another mailbox (not available when replying 
to a message).

• Press 6 to access message addressing options.

• Press \ to cancel the destination mailbox number (not available 
when replying to a message).

• Press 1 to cancel making a message.
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Forward 
Messages

You can forward any non-confidential message in your mailbox to 
another mailbox or distribution list.

If you want you can also add comments to the original message you 
want to forward. When someone plays your forwarded message, your 
added comments are played first, followed by the original message.

Forward a Message
To forward a message:

1. From the Main menu, press 7 to play the message.
2. Press 2 to forward or reply to a message.

3. Press 1 to forward the message.

4. Enter the mailbox number to forward the message or press * and 
distribution list number to forward the message to all members of the 
distribution list.

5. (optional) Press 2 to record your additional comments and press # 
when you are finished recording.

6. Press 9 to forward the message. 

A copy of the current message with recorded comments is forwarded 
to the specified mailbox or distribution list members’ boxes.
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Reply to
Messages

The reply feature allows you to answer a message to the sender without 
addressing it. You can reply to messages sent from mailboxes within 
the Callegra.UC system, but not to messages left from outside callers.

Reply to or Answer a Message
To reply to or answer a message:

1. From the Main menu, press 7 to play the message.
2. Press 2 to forward or reply to a message.

3. Press 2 to answer the message.

4. Record your reply and press # when finished. 

5. Press 9 to deliver the message. 

Your reply is delivered to the original sender’s mailbox.

Reply to a Message with a Live Call
If the sender’s number is identified, you can choose to transfer directly 
to the sender of the message. To reply to a message with a live call:

1. From the Main menu, press 7 to play the message.
2. Press 2 to forward or reply to a message.

3. Press 3 to transfer to sender of message with a a live call.

4. Wait for the telephone to ring and for someone to answer your call.
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Set Message 
Addressing 
Options

You can set the following options for message delivery before you 
send, forward, or reply to a message.

Set Message Addressing Options
After you record a message, but before you deliver it, you can set 
message addressing options. To set the message addressing options:

1. Press 6 for Message Addressing Options.
2. Select one or more of the following:

• Press 1 to request/remove a Return Receipt.
A Return Receipt lets you receive notice when a recipient has 
received and played the message you have sent. This works 
only for internal messages sent from one mailbox to another.

• Press 2 to mark/unmark the message Confidential.
If you mark a message Confidential, it prevents the recipient 
from forwarding that message to another mailbox or 
distribution list.

• Press 3 to mark/unmark for Future Delivery.

If you mark a message for Future Delivery, it lets you send a 
message that you want delivered at a later date and time. You 
must enter two digits for each Future Delivery month and day. 
For example, for July 8th, enter “07” for the month and “08” for 
the day. You must enter time settings in 24-hour format. For 
example, for 1:30 p.m., when prompted first enter the hour as 
“13,” then enter the minutes as “30.”

Note These options are not available for fax addressing.
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Use Email
Features

You can find out how many email messages you have and listen to new 
or saved messages from a telephone. You can also save and delete 
emails from the telephone on your IMAP server. Most enterprise email 
systems are IMAP compatible. To see if you can use email features, 
check with your administrator.

Find out Number of Email Messages
To find out how many existing or new email messages you have, press 
4 for the Email Messages menu.

Listen to Email Messages
To listen to email messages from a telephone:

1. Press 4 for the Email Messages menu.
2. Press 7 to listen to new email messages or press 8 to listen to 

saved email messages.

Save and Delete Email Messages
You can save and delete email messages on your IMAP server using the 
telephone. To save or delete email messages from a telephone:

1. From the Main menu, press 4 for the Email Messages menu.
2. Press 7 to listen to new email messages or press 8 to listen to 

saved email messages.

3. Press 5 to save or press 3 to delete an email message.
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Use Fax 
Features

You can find out if you have a new fax message, save it, forward it to a 
mailbox/fax machine/email account, or delete it from your mailbox.

You can also create and send new faxes from your desktop client when 
CallegraFAX Print Driver is installed on your desktop client machine. 
See “CallegraFAX Print Driver” on page 24 for information on how to 
install the driver.

You can access faxes from your telephone and computer only if your 
company system has CallegraFAX, which is an add-on product 
available separately. To see if you can use fax features, check with your 
administrator.

Retrieve a Fax
To retrieve a fax:

1. Using a telephone (recommended) or fax machine, from the Main 
menu, press 3 for the Fax Messages menu.

2. Press 7 to retrieve new faxes or press 8 to retrieve saved faxes.

3. Press 7 to have the fax sent to you.

4. Do one of the following for:

• Separate call faxing from telephone. Press 2 to have the fax sent 
to a fax machine and enter the area code and phone number 
where you want the fax delivered.

• Same call faxing from fax machine. Press 1 if you are calling 
from a fax machine and you want to send your fax on the “same 
call” (not recommended for more than 1 to 2 pages at a time). 

When you hang up, the fax is sent.
Note Press 3to delete a fax.
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Forward a Fax to Another Mailbox
You can forward a copy of a fax to another mailbox. To forward a fax:

1. From the Main menu, press 3 for the Fax Messages menu.
2. Press 7 to retrieve new faxes or press 8 to retrieve saved faxes.

3. Press 2 to forward the fax.

4. Enter the destination mailbox number.

5. Press 9 to deliver the fax or press 1 to cancel.

Send a Fax
You can create and send new faxes from your desktop client when 
CallegraFAX Print Driver is installed on your desktop client machine. 
See “CallegraFAX Print Driver” on page 24 for information on how to 
install the driver. To send a fax from any windows-based application:

1. Open or create the document you want to fax.
2. Select File > Print as you would if you wanted to send the document 

to a printer. Select the CallegraFAX print driver as the printer. This 
will open the CallegraFAX Print Driver interface.

Have a Fax Sent to Your Mailbox
You can have a fax from an external fax machine sent to your mailbox. 
To have a fax sent from an external fax machine:

1. From an external fax machine, have the external caller, call your 
mailbox from either the main number or the direct extension.

2. Once the greeting is heard, have the external caller, press Start/
Send to start the fax.

3. Retrieve the fax. See Retrieve a Fax on page 10.

See the online help for more information.

Note You can also leave a voice message before sending the fax. To 
do so, wait until the greeting is played and record your 
message. After you are done recording your message, press 
the # key. You are then prompted to press 8 to send a fax. 
Then press Start/Send to start the fax.
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Change 
Mailbox 
Setup 
Options

You can use the following options to change your mailbox setup.

Record or Change Greeting
To record or change your greeting:

1. From the Main menu, press 8 for the User Options menu.
2. Press 1 for the Mailbox Setup menu.

3. Press 1 to record or change your greeting at the Change Greeting 
menu.

4. Press 3 to discard and rerecord the greeting.

5. Press the number of the greeting you want to record and record the 
greeting after the tone.

6. Press 7 to play the greeting and enter the greeting number to play.

Change Passcode
To change your mailbox passcode:

1. From the Main menu, press 8 for the User Options menu.
2. Press 1 for Mailbox Setup.

3. Press 2 for the Change Passcode menu to change the passcode.

4. Press 3 to delete and enter a new passcode (1, 2, or 4 digits long).

5. Enter the new passcode again. The new passcode is then played.

Change Mailbox Name
To change your mailbox name:

Note During the time you are recording your greetings, your mailbox 
does not play a greeting for incoming calls.
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1. From the Main menu, press 8 for the User Options menu.
2. Press 1 for Mailbox Setup.

3. Press 3 to change the mailbox name.

4. Press 3 again to discard current name and record a new one.

5. Press 7 to play the mailbox name.

Assign Call Routing Options
To assign a key to route callers to another voice mailbox:

1. From the Main menu, press 8 for the User Options menu.
2. Press 1 for the Mailbox Setup menu.

3. Press 4 for the Call Routing Options menu.

4. Press 2 to change call routing options.

5. Enter a key to assign to a mailbox number.

6. Enter the mailbox number.

7. While listening to your greeting, callers can transfer to another box 
by pressing the key specified for that mailbox.

Add/Edit Speed Dial Index Numbers
See “Use Speed Dial Numbers” on page 20.

Edit Extended Mailbox Absence 
To avoid unnecessary messages left during an extended absence, 
enable/disable the Extended Mailbox Absence Option:

1. From the Main menu, press 8 for the User Options menu.
2. Press 1 for the Mailbox Setup menu.

3. Press 6 to edit the Extended Mailbox Absence Option. 
Depending upon whether active or inactive, pressing 2 toggles 
between the two options.

4. When your extended mailbox is either active or non active, you want 
to ensure that the appropriate greeting is recorded and active. To 
record a new greeting, “Record or Change Greeting” on page 12

5. Ask your administrator to allow you to record multiple greetings. 
See “Record or Change Greeting” on page 12 to create and assign an 
additional greeting to play during your absence.

Change Your Extension
To change the extension number:
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1. From the Main menu, press 8 for the User Options menu.
2. Press 1 for the Mailbox Setup menu.

3. Press 7 for the Edit Extension Number menu.

4. Press 6 to change your extension number.
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Set up 
Wakeup Calls

You can set up wakeup calls to call you at specific telephone numbers 
and times. Wake up calls can function as alarm clocks or appointment 
reminders.

When you answer a Wakeup call, you hear, “This is your wakeup call.” 
Then you must press 2 to deactivate that call.

Activate/Deactivate the Wakeup Call Plan
To activate or deactivate a wakeup call plan:

1. From the Main menu, press 8 for the User Options menu.
2. Press 4 for the Wakeup Call menu.

3. Enter the wakeup call plan number (1 - 4).

4. Press 2 to activate or deactivate the call.

• Press 3 to edit Wakeup number.

• Press 4 to edit Wakeup time.

Note Contact your administrator if you do not know your wakeup call 
plan number.
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Edit/Play Wakeup Number
1. From the Main menu, press 8 for the User Options menu.
2. Press 4 for the Wakeup Call menu.

3. Enter the wakeup call plan number (1 - 4).

4. Press 3 to edit wakeup number.

5. Either change or play wakeup number:

• Press 3 to change wakeup number and enter wakeup number.

• Press 7 to play wakeup number.

Edit/Play Wakeup Time
1. From the Main menu, press 8 for the User Options menu.
2. Press 4 for the Wakeup Call menu.

3. Enter the wakeup call plan number (1 - 4).

4. Press 4 to edit wakeup time.

5. Either change or play wakeup time.

• Press 8 to change the wakeup time and enter wakeup time.

• Press 7 to play wakeup time.
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Set up 
Notification 
Calls

The Notification Calls feature allows you to:
• Receive notifications from your telephone, email, or pager when you 

receive new voice/fax messages. 

• Have as many as four different notification plans. 

• Schedule a specific time period for all notification types.

• Identify a specific telephone number where you want notifications 
sent (for telephone or pager notifications only).

Activate/Deactivate a Notification Plan
To activate/deactivate a notification plan:

1. From the Main menu, press 8 for the User Options menu.
2. Press 3 for the Notification Calls menu.

3. Enter the number of the notification plan you wish to activate or 
deactivate.

4. Press 2 to activate or deactivate the notification plan.
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Change Notification Phone/Pager Number
If your administrator has given you the required rights, you can change 
your telephone or pager notification numbers. To change a notification 
number:

1. From the Main menu, press 8 for the User Options menu.
2. Press 3 for the Notification Calls menu.

3. Enter the number of the notification plan you wish to activate or 
deactivate.

4. Press 3 to edit your notification number.

5. Follow the prompts to play or change your notification number.

Reschedule the Notification Time 
Each notification plan has a start and end time setting. If your 
administrator has given you the required rights, you can change your 
notification time setting. To change the notification time setting:

1. From the Main menu, press 8 for the User Options menu.
2. Press 3 for the Notification Calls menu.

3. Enter the number of the notification plan you wish to activate or 
deactivate.

4. Press 4 to edit the notification time setting.

5. Follow the prompts to play or set the notification start and end times. 

6. Press 8 to change your notification time.

Receive Notifications
When you answer the phone on a notification attempt, the system 
announces that messages are waiting and asks for your passcode.

If you enter your passcode, all messages waiting at that time are flagged 
as “notification successful” and you are not notified of those messages 
again.

If you do not enter a passcode, the system assumes the notification was 
unsuccessful and will continue to notify you.
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Use 
Distribution 
Lists

A distribution list is a grouping of user mailboxes that you can use to 
send or forward messages to every member of the group in one 
operation.

You can build as many as 48 distribution lists, each one containing up 
to 1000 mailboxes on your system. Your administrator can set up public 
distribution lists, making a total of 100 possible distribution lists.

Create or Edit Distribution List
To create or edit a distribution list:

1. From the Main menu, press 8 for the User Options menu.
2. Press 2 for the Distribution List menu.

3. Press 2 to add or edit a distribution list.

4. Enter the number (0-47) of the list you want to create or edit and 
press #.

5. Press 2 to record the list name while you are editing a list or 
press 6 to add a mailbox to the list.

Listen to a Distribution List Member List
When a distribution list exists, you can listen to the member list from 
the telephone. To listen to distribution list member list:

1. From the Main menu, press 8 for the User Options menu.
2. Press 2 for the Distribution List menu.

3. Press 7 to play the names and numbers contained in the list.
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Use Speed
Dial

You can set up and use as many as 12 speed dial index numbers. This 
includes numbers 0-9 and the characters * and #.

 Play, Delete, or Add/Edit Index Number
1. From the Main menu, press 8 for the User Options menu.
2. Press 1 for the Mailbox Setup menu.

3. Press 5 for the Add/Edit Speed Dial Index menu. Then do one of 
the following:

• Press 7 to play speed dial index number.

• Press 3 to delete a speed dial index number.

• Press 2 to add or edit a speed dial number.

a. Enter a speed dial index number (any single digit number 
0-9 or the characters * or #). Double-digit numbers are not 
allowed.

b. Enter your destination number (up to 50 digits).

Use Speed Dial Numbers
To use a speed dial number:

1. From the Main menu, press 1 for Speed Dial.
2. Enter the speed dial index number. You are transferred to the 

destination number associated with the index number.
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Restore 
Deleted 
Messages

You can restore messages that you have deleted as long as they are 
within the retention time set by your administrator. To restore deleted 
messages:

1. From the Main menu, press 8 for the User Options menu. 
2. Press 5 to access your deleted messages.

3. Press 7 to play your deleted messages.

4. Browse through your deleted messages (using 6 to skip to the next 
message if desired) to locate the message you want to restore. 

5. Press 5 to restore the message. 

The message is brought back to its original state, such as “Saved,” 
with its original date and time.
Note Once the maintenance routine is run, it will delete the message 

again if its retention time is exceeded. If you want to 
permanently store the message, archive the messages using 
either CallegraINBOX for Outlook or CallegraWEB.
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Install
Desktop

Clients

You can listen to voice messages and view/send faxes from your 
desktop client using add-on software products. This section describes 
how to access and set up the following add-on products:
• “CallegraINBOX for Outlook and Exchange Server” on page 22

• “CallegraWEB” on page 23

• “CallegraFAX Print Driver” on page 24

CallegraINBOX for Outlook and Exchange 
Server
If desired, you can install the CallegraINBOX for Outlook or 
Exchange Server that lets you access voice and fax messages 
from your desktop client using Outlook.

Run CallegraINBOX for Outlook Setup

1. Obtain from your administrator the server name. The server name 
is the name of the computer that holds Callegra Client Services.

2. Ensure all prerequisites are installed.

3. Insert Callegra.UC CD1/DVD.

4. From the Autostart menu, select CallegraINBOX for Outlook to 
start the installation.

5. When prompted, enter the server name you received from your 
administrator.

Prerequisites Microsoft Windows XP
Microsoft Outlook XP, 2003, or 2007
Message Queuing Services (MSMQ) - optional prerequisite
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6. Indicate whether you are using https or http. The default is http. If 
you are not sure, check with your administrator. This setting is 
dependent upon the setup within your organization. If it is not set 
correctly, CallegraINBOX for Outlook will not run.

7. The installation might prompt you to run the CallegraFAX Print 
Driver installation. If you want to install it, see “CallegraFAX Print 
Driver” on page 24.

After installing CallegraINBOX for Outlook and logging in, if the 
Callegra Inbox xxxx [Box Number] does not appear, within Outlook 
select View > Folder List. The Callegra Inbox xxxx [Box Number] 
will now appear.

CallegraWEB
CallegraWEB allows you to access voice or fax messages from a 
desktop client with access to the Internet using Internet Explorer or 
higher. 

CallegraWEB is set up by your administrator on a server. There is no 
additional desktop client software to install. 

To access CallegraWEB

1. From Internet Explorer, enter the URL specified for CallegraWEB 
supplied from your administrator.

2. When prompted, enter your Box Number (extension) and Passcode.

If you want to avoid logging in next time you open CallegraWEB 
within Internet Explorer, select the Remember My Credentials 
box.

3. Select OK.

Note After selecting “Remember My Credentials”, to avoid logging in 
the next time you access CallegraWEB, just close the browser 
instead of logging out. If you log out, you need to log in the next 
time to access CallegraWEB.
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CallegraFAX Print Driver
Your administrator must install software and hardware on the server in 
order to use all of the features of CallegraFAX. Once CallegraFAX is 
set up on the server, you can install and use CallegraFAX Print Driver 
to create and send new faxes from your desktop client to a fax machine, 
mailbox, or email account. 

You can send faxes to a fax machine using CallegraFAX Print Driver 
the same way you would use a print driver to send a document to a 
printer to print.

To access and install the CallegraFAX Print Driver

1. Ensure that you have Administrator or Windows Power User 
rights on your Windows machine to ensure a successful installation.

2. Obtain from your administrator the server name. The server name is 
the name of the computer that holds Callegra Client Services.

3. Obtain and run the installation using one of the following methods:

• When prompted after running the CallegraINBOX for 
Outlook install, select Yes to launch the CallegraFAX Print 
Driver install.

• From Callegra.UC CD1 Autostart Menu, launch the 
CallegraFAX Print Driver install.

• From CallegraWEB, select Tools > Download to download and 
launch the FaxSetup.exe file that contains the installation.

4. When prompted, enter the server name you received from your 
administrator.

5. Finish running through the installation until complete.

For more information, see “Send a Fax” on page 11 and the online help.
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N
name, change 12
notification

activate 17
change number 18
change time 18
receive 18
set 17

P
passcode, change 12

S
speed dial numbers

set up 20
to dial 20
use 20

W
wakeup

activate 15
deactivate 15
play settings 15
set 15
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